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CHECKLIST FOR FINAL PRODUCTS 
 
 
Here are the required products and minimum standards for the Vegetation Inventory 
Program: 
 
 

o Digital Aerial Photo Data, Flight Index, Graphic & Metadata 
 
o Technical Project Report (report appendix should include the Vegetation Key) 
 
o Plots Database and Field Photos 

 
o Final Vegetation Map Graphic/Poster using NPS Map Standards 
 
o Vegetation Plots (point data) Spatial Data, Graphic, and Metadata  

 
o Vegetation Map (polygon data) Spatial Data, Graphic, and Metadata 

 
o Park Boundary Spatial Data and Metadata 

 
o Accuracy Assessment  Spatial Data, Graphic, Contingency Table and Metadata 

 
 
 
 
Final Map Specification 
 
Maps are produced in Universal Transverse Mercator (UTM), NAD83 datum with a 
1:24,000 scale and a minimum mapping unit of 0.5 hectares. The vegetation maps must meet the National 
Map Accuracy Standards for positional accuracy and the minimum class accuracy goal across all 
vegetation and land cover classes of 80%. 
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INTRODUCTION 
 
 
The attached guidelines are designed to standardize and thus facilitate the rapid turn-around of Vegetation 
Inventory Program (VIP) final products and get them online as quickly and efficiently as possible.  They reflect 
the USGS’s assistance and decade-long experience on best practices of how to group and parse the NPS VIP 
digital products for the current online environment maintained at the USGS Center for Biological Informatics in 
Denver, CO. 
 
While it is recognized that there will always be exceptions that will have to be dealt with on a case by case 
basis, the NPS and USGS management teams have discovered that adherence to this model of data organization 
and formatting of final products accelerates the turn-around for project data web posting and as such, makes the 
data available to NPS staff, natural resource scientists, federal agencies and the public in a timely manner. 
 
We understand the degree of effort that is required to generate a high-quality, standardized vegetation map 
under the NPS Vegetation Inventory Program.  We recommend you allow sufficient time and effort to produce 
final products adhering to the product specification in this document. 
 
To develop final reports for vegetation mapping projects, investigators should consult with project key officials 
and follow the appropriate NPS guidelines.  The final report will address vegetation classification and 
description, vegetation mapping, and accuracy assessment.  It will include a full description of project methods, 
results and a summary discussion.  The reports should be published in the NPS NRTR series or another 
technical report series.    
 
After the report, maps, databases, and other digital products have been reviewed and accepted as final by the 
project key official, they will be reviewed by the NPS National Vegetation Inventory Program (NVIP) and 
placed on the joint USGS-NPS website.  In order to facilitate this effort, please follow the file format and 
naming convention guidelines provided below. Many projects were initiated prior to the issuance of these 
guidelines by NVIP.  In those cases, investigators should consult with park, network, and/or NVIP staff to 
determine how best to meet the new guidelines. 
 
Any questions, or request for clarification should be addressed to Tammy Cook (Tammy_Cook@nps.gov).   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
We thank Ms. Theresa Singh, VIP data content manager (tsingh@usgs.gov) at USGS CBI, for her ongoing 
assistance with the development of this guide and for her continued work formatting and reformatting final 
products for consistency and web delivery. 
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OUTLINE 
GUIDELINES TO CREATING FINAL PRODUCTS 

FOR THE NPS VEGETATION INVENTORY PROGRAM 
 
I. Aerial Photography 

a. Orthophoto Mosaic Graphic 
b. Spatial Orthophoto Data (.zip) 
c. Flight Line Index – if applicable 

II. Vegetation Information - {one link} 
a. Vegetation Report, containing the following items: 

i. Photo Interpretation Key 
ii. Vegetation Descriptions 

iii. Vegetation Key 
iv. Photos of Map Classes 
v. Accuracy Assessment Methods and Results 

III. Field Data 
a. Field Plots Points Graphic 
b. Spatial Field Plots Data (.zip) 
c. Plots Database (MDB) 
d. MS Excel format of Physical Descriptive Data for Plots 
e. MS Excel format of Species List Data for Plots 
f. Field Photos collected during PLOTS and AA (.zip) 

IV. Geospatial Vegetation Information 
a. Vegetation Graphic 
b. Spatial Veg Data (.zip) 
c. Spatial Boundary Data (.zip) 

V. Accuracy Assessment Information 
a. AA Points Graphic 
b. Spatial AA Data (.zip) 
c. MS Excel Contingency Table 

VI. Project Metadata 
a. Aerial Orthophoto 
b. Field Plots 
c. Spatial Veg Data 
d. Boundary 
e. Accuracy Assessment 
f. Others - as appropriate 

VII. Other Helpful Information for File Creation 
VIII. File Naming Standards 

IX. Appendix A:  Creating Data Visualizations and Symbology (.mdx, .lyr files) 
X. Appendix B:  Creating High Resolution Maps 
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I. Aerial Photography 
a. Graphic File: The pdf file name is the parkname and the type of geospatial data 

being shown, such as Orthophoto. Example: grteortho.pdf.  Example here is a 
photomosaic:  http://biology.usgs.gov/npsveg/grte/images/grteortho.pdf 

b. Spatial Data (.zip): This is a digital file of the land cover (aerial) imagery data 
used in this project.  All geospatial data must be in UTM NAD 83.  In most cases 
this is a CIR mosaic or an orthophoto.  Example: 
http://biology.usgs.gov/npsveg/ftp/vegmapping/grte/grteortho.zip. 

c. Aerial Photo Flightline Index – photos.pdf.  A PDF file of a flightline index 
linking the flightline numbers to the aerial photos and listing the aerial photos by 
numbers. Not all of the aerial photos are shown, just every other one on each 
flightline. Example: http://biology.usgs.gov/npsveg/zion/photos.pdf. 

d. Graphic File: This is a PDF file for each aerial photograph, using a unique photo 
number on each photo. Example: 2-3.pdf, 6-11.pdf, 18-20.pdf, and 23-36.pdf. 
Examples: http://biology.usgs.gov/npsveg/zion/aerials/2-3.pdf, 
http://biology.usgs.gov/npsveg/zion/aerials/6-11.pdf, 
http://biology.usgs.gov/npsveg/acad/aerials/18-20.pdf and 
http://biology.usgs.gov/npsveg/acad/aerials/23-36.pdf. 

1) IMPORTANT – If original roll film for the imagery flight mission can 
be obtained, the NVIP can arrange to have the roll film transferred to the 
USGS EROS Data Center where a permanent archive record will be 
created.  This will remove the need for PDF’s of each image.   

2) If hard copy photos are the only data available and the park coverage 
contains too many photos to reasonably scan to PDF, please contact the 
NVIP to discuss options.   

II. Vegetation Information 
a. Vegetation Report – ONE REPORT: Create a PDF full report (parknamerpt.pdf).  

1) Example:  http://biology.usgs.gov/npsveg/zion/zionrpt.pdf.  
2) Report MUST contain: Vegetation Description, Vegetation Key, Map 

Class Descriptions, Photos of Map Classes, Photo-interpretation Key, 
Accuracy Assessment Methods and Results. 

3) Use the NPS Natural Resource Publication Management for report 
formatting.  There are 5 series.  Most NVIP reports fall under the 
Natural Resource Technical Report Series (NRTR), though some may 
qualify for Natural Resource Report (NRR).  
http://www.nature.nps.gov/publications/NRPM/index.cfm  

III. Field Data 
a. Graphic File: The pdf file name is the parkname and the type of geospatial data 

being shown, such as Plot locations. Example: zionplots.pdf.  Example: 
http://biology.usgs.gov/npsveg/zion/images/zionplots.pdf. 

b. Spatial PLOTS Data: The executable files should contain the geospatial shapefile 
of the PLOTS data. All data must be in UTM NAD83. Example: 
http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/zionplot.zip.  

c. Microsoft Access PLOTS Database: Field Data for Plots, Accuracy Assessment, 
Physical Descriptive and Species Listing Data - parknamedata.mdb.  This is a 
Microsoft Access Database of the park field data, such as accuracy assessment, 
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accuracy assessment species, observation points, plots, plot-species, geology 
classes, locations, jurisdictions and any other park field data.  Example: 
http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/ziondata.mdb. 

d. Physical Descriptive Data for Plots - The plots file is extracted from the 
parknamedata.mdb database. The file name is plots.xls. Example: 
http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/plots.xls. 

e. Species Listing Data for Plots - The sp_cov file is extracted from the 
parknamedata.mdb database. The file name is sp_cov.xls. Example: 
http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/sp_cov.xls. 

f. Field Photographs collected during PLOTS and AA:  Contained within the 
PLOTS database are references to field photos collected as part of the project.  
We would like a .zip or .exe file called “field_photos”. The files within the .zip or 
.exe usually contain jpeg, gif, or pdf format. Please do not exceed 2GB on each 
file. If so than create more than one .zip or .exe file and call it field_photos1.zip or 
.exe, field_photos2.zip or.exe and etc.  * Please make sure that the field photo 
files are identified to link to a ground location in PLOTs.   

IV. Geospatial Vegetation Information 
a. Final Map Graphics: Map layouts need to follow NPS standards.  For NPS 

standard map templates, see: 
http://science.nature.nps.gov/im/inventory/veg/Best_Examples.cfm.  These are 
graphic files (.pdf). The pdf file name is the parkname.  We would like a low 
resolution for viewing and a high resolution PDF for reprinting maps. Examples: 
http://biology.usgs.gov/npsveg/zion/images/zionveg.pdf, 
http://biology.usgs.gov/npsveg/zion/images/zionmap_large.pdf.   For High 
Resolution PDF, see Appendix B for additional assistance.   

b. Spatial Vegetation Data: The ZIP files should contain the following: 
GEODATABASE of the vegetation point and polygon feature classes, Boundary 
feature class, and associated attribute data.  All data must be in UTM NAD83.  

Example: http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/zion.zip. 
Geodatabase Template and Map Symbology Guidance are available here:   
http://science.nature.nps.gov/im/inventory/veg/Best_Examples.cfm 

 
V. Accuracy Assessment (AA) Information 

a. Graphic files (.pdf). The pdf file name is the parknameaa.  Example: zionaa.pdf, 
http://biology.usgs.gov/npsveg/zion/images/zionaa.pdf. 

b. Spatial AA Data:  The executable file which contains the shapefile or geodatabase 
of the Accuracy Assessment geospatial data.  All data must be in NAD83.  
Example: http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/zionaa.zip. 

c. Accuracy Assessment Contingency Table – This accuracy assessment matrix 
(aa_matrix.xls) should include the code description below the matrix. Example: 
http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/aa_matrix.xls. 

VI. Project Metadata 
a. Aerial PhotoMosaic Metadata – metaparknameortho.txt.   Metadata for aerial 

orthophoto mosaic (Text format only). Example: 
http://biology.usgs.gov/npsveg/ftp/vegmapping/grte/metagrteortho.txt. 
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b. Field Plots Metadata – metaparknamefield.txt – Metadata for the PLOT shapefile(s) 
(PLOTS, OBSERVATION POINTS) from the Microsoft Access Database (Text format 
only). Example: http://biology.usgs.gov/npsveg/fobu/metafobufield.html. 

c. Geospatial Metadata - metaparknamespatial.txt – Metadata for Geospatial 
Vegetation Information (Text format only). Example: 
http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/metazionspatial.txt. 

d. Park Boundary Metadata - metaparknamebdy.txt – Metadata for Park Boundary 
(Text format only). Example: 
http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/metazionbdy.txt. 

e. AA Metadata - metaparknameaa.txt – Metadata for Accuracy Assessment 
Information (Text format only). Example: 
http://biology.usgs.gov/npsveg/ftp/vegmapping/zion/metazionaa.txt. 

f. Other metadata, as appropriate 
 
 

VII. Other Helpful Information for File Creation – by Theresa Singh, USGS 
a. Instructions for PDF Conversion of Vegetation Mapping Reports: 

(Instructions refer to MS Word 2002 / Acrobat 7.0 / Reader 9.0) 
 
Hint: PDF conversion is much easier if the Word document you are trying to 
convert is as small as possible. Most graphics are unnecessarily large. To reduce 
them, left click on them, cut, then choose “Picture (JPEG)” from the “Paste 
Special” dropdown under the Edit menu. The graphic/photo should go from 
having little dark handles to having green or white circles for handles. Sometimes 
all you get is a black square, in which case you have to trick Word by choosing 
something else from the Paste Special menu until you get a format that will, when 
pasted as a JPEG, look like your original graphic/photo. Depending on the 
number of photographs and graphics in your document, you can reduce the size 
by an order of magnitude. 

 
1. In creating the parknamerpt.pdf file, you will generally have to break it into 

sections no bigger than 40-50MB in order for the machine not to hang up 
while converting/tagging. Creating the tagged document takes quite a while 
(at least 10 minutes per section) and it is not a good idea to be doing anything 
else on the computer while the conversion is going on.  

a. When all the sections have been converted successfully, run through 
each section and make sure there are no gross errors like extra or 
missing pages, or errors in formatting or page breaks, or strange colors 
invading the figures.  

b. Once all these have been fixed, either in Word and reconverting, or in 
Acrobat, rejoin the sections using the “Insert Pages” command under 
the Document menu. 

c. Once you have a single document, check through the entire thing and 
make sure there are no missing or extra or blank pages, the formatting 
looks good, etc. 

d. Rebuild the TOC at the front of the document to repair the reference 
errors created when you broke it into chunks. 



7 

e. Go through the document page by page with the TouchUp Toolbar 
open (Tools -> Advanced Editing -> Show TouchUp Toolbar) 

f. Activate the TouchUp Reading Order button and on the menu that 
opens, make sure all of the options are checked. Each page will then 
appear as a series of numbered, Xed or grayed-out boxes. 

g. On each page, make sure of the following: 
i. All text, including titles, figure captions and table headings, is 

in gray text boxes 
ii. Figures are in figure boxes 

iii. Tables are in Table boxes 
iv. The numbers in the boxes make sense as to their reading order 

h. If not, and especially if the formatting is a mess with extraneous 
structures and numbered boxes, use the “Clear Page Structure” button 
on the Reading Order TouchUp menu to start over. 

i. Activate the TouchUp Reading Order tool, highlight the text or table 
or figure (all of it, trying not to overlap adjacent structures much or at 
all) and select “Text” or “Table” or “Figure” buttons as appropriate 
from the Reading Order TouchUp menu. Don’t bother with any of the 
other choices. They just complicate things. 

j. You can fix the order of things by clicking on the “Show Order Panel” 
button on the Reading Order TouchUp menu, scrolling to the right 
page number, and using your mouse to drag the various elements 
around (grab the little colored boxes on the left; the text doesn’t drag!) 

k. Tables and Text boxes do not need tags. Figures (photos and graphics) 
do. To create tags for these: 

i. Select the TouchUp Object Tool from the TouchUp Toolbar.  
ii. Right click in the figure you want to tag.  

iii. Select “Properties” from the bottom of the menu 
iv. Select the “Tag” Tab from the properties menu and enter your 

tag text in the “Alternate Text” box. 
v. Select “English US” from the Language dropdown menu below 

the Alternate Text box. 
vi. Use these standards for tagging figures: 

1. For scenic photos, enter a 1 to 4-word description of 
what the photo illustrates: “Yampa River Canyon” 

2. For graphics, enter “Figure XX map” or “Figure XX 
graphic” or “Figure XX chart” – as appropriate 

3. For photographs with captions, enter “Figure XX 
photo” 

4. For photographs without captions, as in the appendices, 
enter a descriptor, like “Acer negundo Woodland 
photo” or “Riparian Shrubland Complex aerial photo 
example” 

5. If there are several photos for a figure, enter the text as 
recommended above, then a number that reflects the 
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reading order number: “Bromus tectorum Herbaceous 
Vegetation photo 1” 

2. When all of this is done and you have checked back through the document to 
make sure nothing was forgotten, *then* fix the bookmarks and links as 
stipulated in the guidelines and finally, run the accessibility check. 

3. Finally, for both PDF reports, while the document is open, click on the 
“Reduce File Size” option under the File menu. You’ll be amazed at how 
much your document shrinks. 

b. DELIVERING A GEODATABASE -VERSUS -SHAPEFILES  
▪ The Vegetation Inventory Program would prefer that all spatial data (e.g. 

PLOTS point data, AA point data, Vegetation polygons, photographs) 
are delivered in one GEODATABASE with the appropriate relationships 
retained.   

▪ Guidance and templates are provided.  See “MAPPING” at: 
http://science.nature.nps.gov/im/inventory/veg/Best_Examples.cfm 

▪ ArcGIS File Geodatabases are recommended.   
▪ Only one Geodatabases is needed, containing all the spatial data.   

VIII:  FILE NAMING STANDARDS: 
 NO capital letters used in naming each file. 
 The following is a list of standard naming conventions: 

▪ Aerial Photography 
o parknameortho.pdf 
o parknameortho.zip  
o photos.pdf 
o 1-02.pdf or 11-13.pdf or 4-5.pdf depending on the unique photo 

number. 
▪ Vegetation Information 

o parknamerpt.pdf 
o class_matrix.xls (OPTIONAL) 

▪ Field Data 
o parknameplots.pdf 
o parknameplot.zip 
o parknamedata.mdb  
o plots.xls 
o sp_cov.xls 
o field_photos.zip – containing photos referenced in the PLOTS DB.   

▪ Geospatial Vegetation Information 
o parknameveg.pdf 
o parknameveg_large.pdf  
o parkname.zip 
o parknamebdy.zip 

▪ Accuracy Assessment Information 
o parknameaa.pdf 
o parknameaa.zip 
o aa_matrix.xls 

■ Project Metadata 
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o metaparknameortho.txt  
o metaparknamefield.txt 
o metaparknamespatial.txt 
o metaparknamebdy.txt 
o metaparknameaa.tx 
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APPENDIX A 
 
 
 
 

DATA VISUALIZATION 
 

CREATING .MXD and .LYR FILES 
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1. Overview 

This guidance documents the process of visualizing the vegetation data produced by the National 
Park Service Biological Resource Management Division Vegetation Inventory Project using 
ArcGIS map documents (MXD) and layer (LYR) files. The goal is to categorize and map distinct 
vegetation classes (communities) within NPS units for GIS display by applying to geospatial 
datasets common symbology.  Ideally, the same symbology will be used for the MXD, LYR 
file(s), and PDF documents generated from the maps.   

Deliverables should include the ArcMap MXD(s), the ArcMap layer file(s), and PDF maps 
generated using the layer files.  

The data sources and tools used are assumed to be compatible with at least ESRI ArcGIS™ 
format, version 9.3.1 Service Pack 1 or version 10 Service Pack 1. ArcGIS version 10 is used in 
examples and specific processing directions apply to this version.   However, the process will be 
nearly identical in version 9.3.1. 

Arches National Park (Unit Code = ARCH) will be used as the example in many steps.  

2. Create an ArcMap Document and Symbolize Vegetation 
Polygon Data 

To aid visualization in GIS packages, the vegetation inventory polygon feature class needs to 
have symbology applied. This may involve table joins and/or manually applying those color 
values to the map classes in ArcMap. 

The optimal situation is to use MAP UNIT CLASSES to define map symbology.   

1. Open ArcMap. Click the Add Data button  to add the vegetation polygon feature 
class.  

In the ArcMap toolbar, navigate to the directory where the data is saved and add the 
Vegetation Polygons (fcl_VegPolys) feature class from the geodatabase to the ArcMap 
document. 
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2. Find a field on which to base symbology: Open the attribute table for the fcl_Veg_Polys 
feature class: right-click on fcl_Veg_Polys Open Attribute Table.  Look for a field that 
contains text values for the map classes. This will usually be a field called something like 
“Map_Unit_ID”, “Map_Unit_Common_Name” or “Map_Class”.    

3. Change the symbology source to the selected field:  Right click on fcl_Veg_Polys    
Properties  Symbology tab 
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a. In the left hand column choose Categories Unique Values 

b. In the Value Field box at the top, scroll down and choose choose the field that you 
found in step 2 above 

c. Click the Add All Values button near the bottom, a dialogue box will pop up as 
ArcMap populates the field 

d. Click OK.  
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4. Change colors to better reflect the information content of the vegetation polygons.     

 

 

a. In the ArcMap Symbology viewer, right-click on the color patch for the class you 
are working on under fcl_Veg_Polys. A window allowing you to change the 
symbology appears. 

b. Find the box on the right called Fill Color and click it; a window of colors 
appears, on the bottom of this window select More Colors, a second window 
appears on top of the first. 
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c. In the upper right corner of the Color Selector window choose RGB (not HSV or 
CMYK) from the drop down box. 
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d. Select an appropriate color. Note down the respective red (R), green (G) and blue 
(B) values. Click OK. 

e. Under the Fill Color box is the Outline Color box, click on it and choose No 
Color at the top to remove outline from the polygons. 
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f. Done! The map class in ArcMap should now have an appropriate color symbol. 

g. Repeat these steps for each class in the fcl_Veg_Polys feature layer. 

h. Once all classes are symbolized, export the symbology as a Layer file so that it 
can be preserved and this process won’t need to be repeated. Right click on 
Veg_Polys  Save as Layer File. Save the layer in your working directory. A 
recommended naming convention is:  

<UNIT_CODE>_veg_polys.lyr  

 (ex. ARCH_veg_polys.lyr) 

i. Save the ArcMap document. A recommended naming convention is: 

<UNIT_CODE>_vegetation.mxd 
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3. Symbolize Vegetation Point Data 

The point data is more straightforward to symbolize than the polygon data. The first step is to investigate 
what kind of point data is contained in the source. Most parks will have two point feature classes in the 
Vegetation dataset; fcl_Veg_Points and fcl_Veg_Specials. The fcl_Veg_Points feature class can contain 
four different kinds of points: Accuracy assessment points (AA_Point), Fuels assessment points 
(Fuels_Point), Observation points and Plot points. The Veg_Specials feature class contains only one type 
of point.  

1. Look at the source data to determine what kind of point data is present for the park. Most 
parks will have Veg_Points and Veg_Specials but it is not uncommon for the 
Veg_Specials to be missing. 

2. Copy the layer files into the directory with the geospatial data 

3. Add the layers into Arc Map and change the data source to reflect the park being 
processed.  

4. Change the layer names in the table of contents from fcl_Veg_Points and 
fcl_Veg_Specials to Vegetation Points for *Park Name* and Special Vegetation Points 
for *Park Name* respectively.  

5. Save the layer file with the following naming convention:  

<UNIT_CODE>_veg_points.lyr 

6. Repeat with the Veg_Specials feature class, if it exists.  

<UNIT_CODE>_veg_specials.lyr 

7. Save the ArcMap document. 

 

4. Export PDF Documents Using Layer Files 

PDF documents should be generated using the layer files defined in steps 3 and 4 above.  
Additional instructions are provided in this document -  Final Product Guidelines, Appendix B.    

1. Open the ArcMap document.  Switch to layout view and format the map layout as 
desired, using the layer files defined in steps 3 and 4.   

2. Export a PDF of the map using 300dpi as the default setting.  
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5. Quality Control 

5.1. Verify Visual Continuity 

1. Open a new ArcMap document and add the newly created layer files using the Add Data 
button. 

2. Check that all class names in the map legend visible in the ArcMap table of contents. 

3. Visually check that the colors of classes, looking for visual distinction and continuity. 

4. Include the ArcMap document(s), layer files, and PDF file(s) as deliverables for the 
vegetation map. 

6. Appendices 

6.1. Using Joined Tables as a Symbology Choice 

1. Add table data: Click the Add Data button in the toolbar, navigate to the directory where 
the data is saved and add two tables from the geodatabase into the document. 
TBL_VEGMAP_INFO and TBL_MAPUNIT_ECOSYS. Hold down the control key to 
select multiple items and then click the add button 
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2. Join tables to Vegetation feature class: In order to crosswalk from the native classes in 
the data to the ecological system classes used in the map, joins must be made to the two 
tables added in the previous step: 

a. Right click on TBL_VEGMAP_INFO Joins and Relates   Join 

b. In the dialogue box that opens leave the top box as “Join attributes from a table”. 
In the box labeled 1 choose Map_Unit_ID as the field to base the join on. In the 
box labeled 2 choose TBL_MAPUNIT_ECOSYS as the table to join to. In the 
box labeled 3 choose Map_Unit_ID as the field to base the join on. Under Join 
Options select the bottom radio button “Keep only matching records”. Click OK 
to perform the join. 

 
 

c. Join to Veg_Polys:  Right click on Veg_Polys Joins and Relates Join 

d. In the dialogue box that opens leave the top box as “Join attributes from a table”. 
In the box labeled 1 choose Map_Unit_ID as the field to base the join on. In the 
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box labeled 2 choose TBL_VEGMAP_INFO_TBL_MAPUNIT_ECOSYS as the 
table to join to. In the box labeled 3 choose Map_Unit_ID (second from top) as 
the field to base the join on. Under Join Options select the bottom radio button 
“Keep only matching records”. Click ok to perform the join 

e. Pick up processing steps from Section 4.1 step a. 

 
 
  



24 

APPENDIX B 
 

Guidelines for Creating a High Resolution Vegetation Map Graphic for 
Posting on the USGS-NPS Vegetation Mapping Program Web Site 

 
February 2009 

 
IMPORTANT:  If you have two versions of the final vegetation map, be sure to use the version 
designed for public distribution, that is, the version that conceals locations of rare species. 
 
1. In ArcMap, use the final vegetation map shapefile to create a layout using one of the NPS 

Graphic Identity Program standard map templates.  You can download the templates at: 
http://science.nature.nps.gov/im/inventory/veg/Best_Examples.cfm.   

Each download file contains directions on how to load and use the templates. 
 
2. Use either the D or E size, landscape or portrait template (.mxt), as appropriate.   

(Size D = 22 x 34 inches; Size E = 34 x 44 inches) 
 
3. Please be sure that the black NPS banner is displayed at the top of the page.  Follow general 

map creation rules, for example, be sure to include a scale bar, north arrow, projection 
information, map author, map creation date, etc.  

 
4. In ArcGIS, EXPORT the layout to a PDF using the following settings: 
 

File name:  xxxxmap_large.pdf (where xxxx = 4-letter park acronm) 
 
Save as type:  PDF 
 
/Options 

General Tab: 
Resolution:  600 dpi (or less if file size is too large using 600 dpi) 
Output Image Quality (Resample Ratio):  Normal - Best 
Ratio:  1:1 

Format Tab: 
Destination Colorspace:  RGB 
Check box for:  Compress Vector Graphics 
Image Compression:  Deflate 
Picture symbol:  Rasterize layers with bitmap markers/fills 
Check box for:  Convert Marker Symbols to Polygons 
Check box for:  Embed All Document Fonts 

Check box for:  Clip Output to Graphics Extent 
 

For maps with large extents or that use a DEM backdrop, you may need to lower the DPI 
and/or output image quality settings to obtain a manageable file size. 
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A PDF file is requested so that it can be reproduced and printed at various sizes without 
running into issues with resizing and loss of resolution that could be encountered with 
JPEG or other image formats. 

5. The goal of the high resolution map is to create a printable layout that can be displayed as a 
poster.  To see some good examples, view the “Large Graphic of Vegetation 
Communities…” from the following web sites: 

http://biology.usgs.gov/npsveg/colm 
http://biology.usgs.gov/npsveg/dino 
http://biology.usgs.gov/npsveg/nabr 
http://biology.usgs.gov/npsveg/zion 

 
6. Questions or requests for clarification should be addressed to: 

Tammy Cook  
Biologist, Vegetation Inventory  
National Park Service, Natural Resource Program Center  
1201 Oakridge Drive, Suite 200, Fort Collins, Colorado 80525  
970‐267‐7201 (phone) 
Tammy_Cook@nps.gov 

 
 


